PostScript 3 Supplement

Introduction 3

1. Using PostScript 3

Setting up Options 5
JOD TP Pttt ettt ettt e h ettt h e bt bt et e at bt et bt ea bt et sbeenae s st et e ebeebeas 5
COLLALE ...ttt ettt e h et he et b et s bt s b sb b et e et et eh e e bt e a et eh e ettt et e b eh e ea bt b e et bt et et eaes 13
DUPLEX PIINEINE .c.eteieiiiiiieiet ettt ettt st eat e bt et sbe e b e e e s bt eb b e bt eab e ebeenbesbeenaeeaee 14
COLOT MOTE ...ttt ettt st et b et bt ea e e bt et eb e e s bt e et sbe bt eb b e e bt eab e ebe et ebeenaesaee 16
PAPET SELECTION ..ottt ettt b ettt eae e s bt et sbe et bt et e s bt est e e bt enb e ebe e bt ebeenaeeaee 17
PAPET SIZE ..ottt ettt e a et et b bbbt bttt et h e ea et b et sbt et et eees 18
IMEAIA TYPC ..ttt et s e ettt a et et eb e et ae 19
PAPET SOUICE ...c.eeueiieie ettt ettt ettt et bt et st et sh e e be bt e e e s bt ebt e e bt e st e ebe ettt e ebeembenbeenaesaee 20
RESOIULION ..ttt ettt b et et eb e s bt bt sa e et b e et e bt ebbe st enbe et e sbeeneeeaeenees 20
GRAQALION <.ttt ettt e a e bbbt e bt e st bt et s bt e e e s bt e s bt e aten bt eb e e bt eb b e sbeeat e bt entesbeenteeaeenees 21
COLOT PIOTILE ...ttt et b et sttt be et eb et e bt st ettt sbe et ebeeneeeaee 22
COLOT SN ...ttt sttt ettt et b et s bt a e e bt et bt et sb e e saeea b e bt et e bt eb e e bt ebbesbeeates b e sbeenbenbeeneesaee 24
DIERETING .ttt ettt b et bt e st s ae et eh e et e bt e e e s bt ea b e e bt e st ebe e eb b et e ebe et beenaeeaee 26
Gray RePrOQUCTION. ..c..coiuiiiiiiiieiicteettet ettt et ettt et st e st st e e et e bt ebt e s bt ea b e ebe et eebeenaeeae 27
BIACK OVET PIINT ..cntiiiiiiiiiiiiiieeete ettt ettt sttt et bt eb e s bt et st ettt etesbeenaeemeenees 28
TONET SAVINZ ...cuiiiiiiiiiiiii ettt et sttt et et e b et ae e ae b sa e sa et e b saeebebesuebesbeaens 29
COLOT COMIIOL ...ttt ettt ettt s b e bbbt e e bt ea e sbe et e ebeesbeea e e sbe bt ebteebtesbentesbtenteemeenees 29
USEE COAE ..ttt ettt et e h et b et et et e eb e e s bt s bt e s bt e bt et e es b e s bt est e st e abeenaesatembeeaeenees 30
OPLIOMS ..ttt ettt sttt ettt ettt et e st e bt s bt e st e bt et e bt et e e bt ea bt e bt ea bt eb e et s bt e eae e a e et e et e b et ea e b e et sheenbe et enees 31



<

2. Printer Utility for Mac

Installing Printer Utility for Mac 33
Starting Printer Utility for Mac 34
Printer Utility for Mac Functions 35
DoWnIloading PS FONLS .......ooiiiiiiiitee ettt ettt sttt e te s e st e st e eneeeseeneeeseenseeneansesneensesneeenns 36
Displaying Printer's FONES........ccieiiriieiiiieieee ettt ettt et et e st e ae s e stesseenseessenseeseanseeneeneeenes 38
DLELING FONLS ....ceeiieeeiiieet ettt ettt et ettt et e et e e ee e st eneesaeensesse e seseenseeseenseensensesesnsenseeneenns 38
Initializing the Printer DISK ........ccoiiiiiiiii ettt st sae sttt e st et sseeeesneenseeneennas 39
PAZE SELUP ..ottt ettt ettt e et e bt et e sb e st e bt bt e e st eeat e s be et e bt e st e e s e e nate 40
Printing FONt Catalog........oceeieiiieieiieiete ettt ettt ettt et e et see et e et et e eeeseesaeeneesaeemsenseessenseeseanseeneaneenss 40
Printing FONt SAMPIE .......ooiuiiiiiiieiee ettt ettt et e st esae e se st e aesseeneeesaenseeseenseeneeneennas 40
ReNaMING the PriNLET .......cocuiriiiiieieieee ettt ettt et ente st et e e e e ae st eseeseenteessenseeseenseeneeneennas 41
REStArting the PIINLET .......cocuieiieiiieeieie ettt ettt ettt e st e e e s e e e saeentens e et e seenseensenseeseanseeneaneenns 42
Downloading POStSCIIPt FILES .......ooiiiiiiieieeeeeee ettt ettt eae et st e sae e seeneenes 42
SEIECHNGZ thEe ZIOME .....eeeieiieiieeeiee ettt ettt et e st s e te e st e et e te st eneesseeneesaeantesseensanseeneanseeneesneensesseensesneas 43
Displaying the PriNter STALUS .......cc.eeuieriirieiiee ettt ettt ettt ettt et e seeseesseeneessesnsensesssenseeseanseeneenseenes 44
Launching the Dialogue CONSOLE. ........cecuiririieriierieciieie ettt ettt et e st eee et ee st e se st e stesseensesnsenseeseansesneasseenns 44

INDEX 46




<«

Introduction

To get maximum versatility from this machine all operators should carefully read and follow the in-
structions in this manual. Please keep this manual in a handy place near the printer.

Please read the Safety Information before using this printer. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be
liable for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe® and PostScript® are registered trademarks of Adobe Systems Incorporated.

Appletalk, Apple, Macintosh, Mac OS, Mac OS X is a registered trademark of Apple Computer, Incor-
porated.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

The proper names of the Windows operating systems are as follows:

¢ The product name of Windows® 95 is Microsoft® Windows 95.

¢ The product name of Windows® 98 is Microsoft® Windows 98.

+ The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

 The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

y
y
y
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 The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

 The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

*  Microsoft® Windows NT® Workstation 4.0

Notes:

Certain options might not be available in some countries. For details, please contact your local dealer.
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1. Using PostScript 3

Setting up Options

This documentation describes the specific printer functions and menus that are added by installing the
PPD file. For more information about the functions and menus of the Windows 95/98/Me PostScript
printer driver, see the printer driver's Help.

= Preparation
On a Macintosh, Mac OS 8.6 or later (Mac OS X Classic environment is supported.) or Mac OS X
10.1 or later is required.

® Limitation

O If you use Mac OS X, the following functions cannot be used:
* Sample Print
* Locked Print
* User Code

Job Type

Use this to select the type of print job.
The following table shows the tabs or menus where you can select this function.

Windows 95/ 98/ Me [Job Type] on the [Setup] tab.

Windows 2000, Windows XP [Job Type] on the [Job Log] tab in the Printing Preferences dialog box.
Windows NT 4. 0 [Job Type] on the [Job Log] tab in the Document Defaults dialog box.
Mac OS [Job Type] on [Job Log] in the print dialog box.

Mac OS X This function is not available.

You can select the following items: l )
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Normal
Select this for normal printing. The print job starts immediately after the print command is given.

& Note
3 Under Windows 95/98/Me, if you want to use an User ID, click the [Detail] button.

Sample Print

Use this function to print only one set of a multiple print jobs.

The other sets are saved in the machine. The saved job can be printed from the machine's control
panel. You can also delete the saved job.

? Limitation
O To use this function, the optional Hard Disk Drive must be installed on the printer.

& Note
3 The "User ID" can consist of up to eight alphanumeric (a- z, A- Z, 0- 9) characters.
O Entering the "User ID" helps you to distinguish the print job from others.

A Reference
For more information about how to use Sample Print, see p.7 “How to Use Sample Print”.

Locked Print

Use this function to save documents in the machine memory with a password, and then edit and print
them as you want.

? Limitation
O To use this function, the optional Hard Disk Drive must be installed on the printer.

& Note

3 The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters. The "Password"
must be four digits.

g
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A Reference
For more information about how to use Locked Print, see p.10 “How to Use Locked Print”.

How to Use Sample Print

Follow the procedures to print a document using the "Sample Print" function.

& Note

3 If the application has a collate option, make sure that it is not selected before sending a print job. By
default, sample print jobs are automatically collated by the printer driver. If the collate option is se-
lected in the application print dialog box, more prints than intended may be printed.

Windows 95/98/Me

n From an application, select the menu command to print.
The print dialog box appears.

B Open the Printer Properties to set Sample Print.
B Click to select the [Setup] tab.

ﬂ Select [Sample Print] in [Job Type].

B Click [Details...].

E Enter the "User ID" in [User ID]. This can consist of up to eight alphanumeric (a- z, A- Z, 0- 9)
characters.

& Note
O Select this to identify the user associated with the job.
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Windows 2000, Windows XP, Windows NT 4.0

n From an application, select the menu command to print.
The print dialog box appears.

B Open the Printer Properties to set Sample Print.
B Click to select the [Job Log] tab.
ﬂ Select [Sample Print] in [Print Job].

B Enter the "User ID" in [User ID]. This can consist of up to eight alphanumeric (a- z, A- Z, 0- 9)
characters.

& Note
O Select this to identify the user associated with the job.

E Click [OK] to close the Printer Properties.

ﬂ Start printing from the application's print dialog box.
The Sample Print job is sent to the machine and one set is printed.

B Check the sample print to confirm that the settings are correct.
If the settings are correct, see "Printing the Remaining Sets" in the Client Reference.
If not, you can delete the saved job. See "Deleting a Sample Print File" in the Client Reference.
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Mac OS

n From an application, select the menu command to print.

The print dialog box appears.
B Click to select [Job Log] from the pop up menu.
B Select [Sample Print] in [Job Type], and then select the appropriate setting.

ﬂ Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
characters.

& Note
3 This is used to identify the user associated with a job.

3 The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

B After making all of the settings you want, click [Print].
The Sample Print job is sent to the machine and one set is printed.

E Check the sample print to confirm that the settings are correct.
If the settings are correct, see "Printing the Remaining Sets" in the Client Reference.
If not, you can delete the saved job. See "Deleting a Sample Print File" in the Client Reference.
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How to Use Locked Print

Follow the procedures to print a document using the "Locked Print" function.

& Note

3 If the application has a collate option, make sure that it is not selected before sending a print job. By
default, locked print jobs are automatically collated by the printer driver. If the collate option is se-
lected in the application print dialog box, more prints than intended may be printed.

Windows 95/98/Me

n From an application, select the menu command to print.
The print dialog box appears.

B Open the Printer Properties to set Locked Print.
B Click to select the [Setup] tab.

ﬂ Select [Locked Print] in [Job Type].

B Click [Details...].

E Enter the "User ID" in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
characters. Then enter a password in [Password], up to four digits.

& Note
O Select this to identify the user associated with the job.

0 ciick [0k
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Windows 2000, Windows XP, Windows NT 4.0

n From an application, select the menu command to print.
The print dialog box appears.

ﬂ Open the Printer Properties to set Locked Print.
B Click to select the [Job Log] tab.
ﬂ Select [Locked Print] in [Print Job].

B Enter the "User ID" in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
characters. Then enter a password in [Password], up to four digits.

& Note
O Use this to identify the user associated with the job.

E Click [OK] to close the Printer Properties.

ﬂ Start printing from the application's print dialog box.
The Locked Print job is sent to the machine.
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Mac OS

n From an application, select the menu command to print.

The print dialog box appears.
ﬂ Click to select [Job Log] from the pop up menu.
B Select [Locked Print] in [Job Type], and then select the appropriate setting.

ﬂ Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
characters. Then enter a password in [Password], up to four digits.

& Note
3 This is used to identify the user associated with a job.
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Collate

Use this function to enable collation. With this feature, the printer can efficiently print collated sets of
multiple-page documents.

® Limitation

3 To use this function, a Memory Unit of at least 128MB or Hard Disk Drive must be installed on the
printer.
O If you use Windows 2000, Windows XP, Mac OS or Mac OS X, make sure that the following check
boxes have not been selected.
*  Windows 2000, Windows XP
The [Collated] check box on [Paper/Output] on [Advanced...] on the [Paper/ Quality] tab in the
Printing Preferences dialog box.
* MacOS
The [Collate] check box in the print dialog box.
e MacOSX
The [Collate] check box on [Copies & Pages] in the printer dialog box.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Collate] on the [Setup] tab.

Windows 2000, Windows XP [Collate] on [Advanced...] on the [Paper/Quality] tab in the Printing
Preferences dialog box.

Windows NT 4.0 [Collate] on [Document Options] on the [Advanced] tab in the Docu-
ment Defaults dialog box.

Mac OS [Collate:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Collate] on the [Feture 1] tab on [Printer Feature] in the printer dialog box.
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Duplex Printing

Use this function to select duplex printing.

? Limitation

3 To use this function, the optional Duplex Unit must be installed on the printer.
3 You cannot perform duplex printing from the Bypass Tray.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Duplex] on the [Setup] tab.

Windows 2000, Windows XP [Print on Both Sides (Duplex)] on the [Layout] tab in the Printing Pref-
erences dialog box.

Windows NT 4.0 [Print on Both Sides (Duplex Printing)] on the [Page Setup] tab in the
Document Defaults dialog box.

Mac OS [Print on Both Sides] on [Layout] in the print dialog box.

Mac OS X The [Print on both Sides] check box on [Duplex] in the print dialog box.

You can select the following items: The following items may vary depending on the operating system
you are using.

Windows 95/98/Me

< Off
Disables Duplex Printing.

< Open to Left

Prints output so that you can open it to the left.
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< Open to Top

Prints output so that you can open it to the top.

Windows 2000, Windows XP, Mac OS, Mac OS X

& Note
3 If you use a Macintosh, click to select the button that means [Flip on Long Edge] or [Flip on Short Edge].

+ None
Disables Duplex Printing.

« Flip on Short Edge

Prints output so that you can open it to the short edge when bound along the short edge.

< Flip on Long Edge

Prints output so that you can open it to the long edge when bound along the long edge.

Windows NT 4.0

% None
Disables Duplex Printing.

< Short Side

Prints output so that you can open it to the short edge when bound along the short edge.

% Long Side

Prints output so that you can open it to the long edge when bound along the long edge.
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Color Mode

Use this to select whether the document is printed in color or black and white.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Color Mode] on the [Setup] tab.

Windows 2000, Windows XP [Color Mode] on [Advanced...] on the [Paper/Quality] tab in the Print-
ing Preferences dialog box.

Windows NT 4.0 [Color Mode] on [Document Options] on the [Advanced] tab in the
Document Defaults dialog box.

Mac OS [Color Mode:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Color Mode] on the [Features 1] tab on [Printer Features] in the print
dialog box.

& Note

3 If you use Windows 95/98/Me, this mode is called "Color/Black and White".
You can select the following items:

< Color
Prints color documents in full color.

& Note
3 Color images will be printed using CMYK toner, Cyan, Magenta, Yellow and Black. CMYK are
three primary subtractive colors.

3 If you want to adjust the print color, adjust the settings in the Advanced dialog box accessed from
the Advanced button on the [Print Quality] tab.

g
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+ Black and White
Prints everything, including color documents, in black and white. Black and White printing is faster
than Color printing. To stop black and white areas being printed with CMYK toner, select [Black
and White] in the printer driver as well as in the application.

Paper Selection

Paper Sources and Output Tray Tabs

Use this to select the media type, input tray, and output tray.

® Limitation

3 This function is for Windows 95/98/Me only.

~ Reference
For more information about the [Paper Sources and Output Tray] tabs. See the printer driver's Help.
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Paper Size

Use this to select the size of paper you want to use.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Size:] on the [Paper] tab.

Windows 2000, Windows XP [Paper/Output] on [Advanced...] on the [Paper/Quality] tab in the Print-
ing Preference dialog box.

Windows NT 4.0 [Paper Size:] on the [Page Setup] tab in the Document Defaults dialog
box.

Mac OS [Paper:] on the [Page Attributes] tab in the Page Setup dialog box.

Mac OS X [Paper Size:] in the Page Setup dialog box.

A Reference

For more information about the paper sizes supported by this printer, see "Paper and Other Media
Supported by This Printer" in the Maintenance Guide.
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Media Type

Use this to select the paper type.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Type:] on [All Pages] on the [Paper] tab.
Windows 2000, Windows XP [Media:] on the [Paper/Quality] tab in the Printing Preference dialog
box.
Windows NT 4.0 [Paper/Output] on the [Advanced] tab in the Document Defaults dialog
box.
Mac OS [Paper Type:] on [Printer Specific Options] in the print dialog box.
Mac OS X [Paper Type] on the [Features 3] tab on [Printer Features] in the print
dialog box.
~ Reference

For more information about the media type supported by this printer, see " Types of Paper and Other
Media" in the Maintenance Guide.
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Paper source

Use this to select the paper sources.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [All Pages] on the [Paper] tab.

Windows 2000, Windows XP The [Paper/Quality] tab in the Printing Preferences dialog box.
Windows NT 4.0 The [Page Setup] tab in the Document Defaults dialog box.
Mac OS [Paper Source:] on [General] in the print dialog box.

Mac OS X [Paper Feed] in the print dialog box.

Resolution

Use this to set the resolution to [600dpi] or [1200dpi].

? Limitation
3 When the resolution option is set to [1200dpi], the gradation option must be set to [Fast].
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Advanced] on the [Print Quality] tab.
Windows 2000, Windows XP [Graphic] on [Advanced...] on the [Paper/Quality] tab in
the Printing Preferences dialog box.
Windows NT 4.0 [Graphic] on [Document Options] on the [Advanced] tab
in the Document Defaults dialog box.
Mac OS [Printer Specific Options] in the print dialog box.
Mac OS X [Resolution] on the [Features 1] tab on [Printer Features]
in the print dialog box. y
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Gradation

Use this to select a type of gradation based on your purpose.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me

[Print Quality] tab.

Windows 2000, Windows XP

[Gradation] on [Advanced...] on the [Paper/Quality] tab in the Printing
Preferences dialog box.

Windows NT 4.0 [Gradation] on [Document Options] on the [Advanced] tab in the Doc-
ument Defaults dialog box.

Mac OS [Gradation:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Gradation] on the [Features 1] tab on [Printer Features] in the print di-

alog box.

You can select the following items:

+ Standard
Prints with good quality of gradation.

< Fast

Prints quickly while gradation loses some smoothness.
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Color Profile

Use this to select the color profile pattern.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me The [Print Quality] tab.

Windows 2000, Windows XP [Color Profile] on [Advanced...] on the [Paper/Quality] tab in the Print-
ing Preferences dialog box.

Windows NT 4.0 [Color Profile] on [Document Options] on the [Advanced] tab in the
Document Defaults dialog box.

Mac OS [Color Profile:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Color Profile] on the [Features 2] tab on [Printer Features] in the print
dialog box.

You can select the following items:

i@klmportant

3 If you use Windows 95/98/Me, you can configure [Color Profile] in [Advanced] by selecting [Manual]
from the[Color] setting. [Automatic] sets the printer to "Auto".

% Auto
Use this setting to configure the best color profile pattern automatically depending on the appear-
ance of the document to be printed.

< Photographic

Use this setting to enhance the reproduction of photos and graphics that include midtones.
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% Presentation
Use this setting to enhance the reproduction of documents that contain text and graphics. This CRD
is best for printing colored charts, graphs, presentation materials and so on. If you use this CRD for
printing photographs, the color or gradations might not be reproduced well.

% Solid Color
Use this setting to print specific colors, logos and so on.

< User Setting
Use this setting to print images with downloaded CRD from your application.

& Note

O Use this to select a color rendering dictionary (CRD). The CRD is referred to color matching, so you
should select the appropriate CRD for the document you are printing. The selected CRD is also re-
ferred to when [Fine] or [Super Fine] is selected for "Color Setting". The following items are available:
[Auto],[Photographic], [Presentation] and [Solid Color].
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Color Setting

Use this to select the correction method used for color conversion.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Advanced] on the [Print Quality] tab.

Windows 2000, Windows XP [Color Setting] on [Advanced...] on the [Paper/Quality] tab in the Print-
ing Preferences dialog box.

Windows NT 4.0 [Color Setting] on [Document Options] on the [Advanced] tab in the
Document Defaults dialog box.

Mac OS [Color Setting:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Color Setting] on the [Features 2] tab on [Printer Features] in the print
dialog box.

i@klmportant

3 If you use Windows 95/98/Me, you can configure [Color Setting] in [Advanced] by selecting [Manual]
from the [Color] setting. [Automatic] sets the printer to "Super Fine".

& Note
O The color rendering dictionary that is selected in the "Color Profile" setting is used.
You can select the following items:

% Off

No modification to the color setting.
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% Fine
Select this setting to perform color matching based on one of the printer's built- in color rendering
dictionaries and perform CMYK conversion. This setting performs the printing which output target
is Monitor y=1.8.

< Super Fine
Select this setting to use a color rendering dictionary as in the "Fine" setting but produce output that
is more vivid. Use this setting to emphasize light colors. This setting performs the printing which
output target is Monitor y = 2.2.

& Note

O Use this to select a color rendering dictionary (CRD). The CRD is referred to color matching, so you
should select the appropriate CRD for the document you are printing. The selected CRD is also re-
ferred to when [Fine] or [Super Fine] is selected for "Color Setting". The following items are available:
[Auto],[Photographic], [Presentation] and [Solid Color].
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Dithering

Use this to set the Image Rendering mode.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Advanced] on the [Print Quality] tab.

Windows 2000, Windows XP [Dithering] on [Advanced...] on the [Paper/Quality] tab in the Printing
Preferences dialog box.

Windows NT 4.0 [Dithering] on [Document Options] on the [Advanced] tab in the Doc-
ument Defaults dialog box.

Mac OS [Dithering] on [Printer Specific Options] in the print dialog box.

Mac OS X [Dithering] on the [Features 2] tab on [Printer Features] in the print di-
alog box.

i@klmportant

3 If you use Windows 95/98/Me, you can configure [Dithering] in [Advanced] by selecting [Manual] from
[Color] setting. [Automatic] sets the printer to "Auto”.

You can select the following items:

% Auto
Use this setting to configure the best dithering method automatically depending on the appearance
of the document to be printed.

+« Photographic

Performs dithering using an appropriate pattern for photographs.

% Text
Performs dithering using an appropriate pattern for text. ’
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% User Setting
Use this setting to print images set in half tone in your application.

Gray Reproduction

Use this to select the Black Color mode for text and line art.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Advanced] on the [Print Quality] tab.

Windows 2000, Windows XP [Black Text/ Graphics] on [Advanced...] on the [Paper/Quality] tab in
the Printing Preferences dialog box.

Windows NT 4.0 [Black Text/ Graphics] on [Document Options] on the [Advanced] tab
in the Document Defaults dialog box.

Mac OS [Black Text/Graphics] on [Printer Specific Options] in the print dialog
box.

Mac OS X [Black Text/Graphics] on the [Features 2] tab on [Printer Features] in
the print dialog box.

i@klmportant

O If you use Windows 95/98/Me, you can configure [Gray Reproduction] in [Advanced] by selecting [Man-
ual] from the [Color] setting. [Automatic] sets the printer to "Pure Black Text".

& Note
O If you use Windows 2000, Windows XP, Windows NT 4.0, Mac OS or Mac OS X, this function is
called "Black Text/Graphics".

You can select the following items:
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< Pure Black Text
Select this setting to use a black toner.

& Note

O If you use Windows 2000, Windows XP, Windows NT 4.0, Mac OS or Mac OS X, this mode is
called "K".

< CMY+K

Select this setting to use all toners.

Black Over Print

Select whether or not to apply a black color over any other colors when printing.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Advanced] on the [Print Quality] tab.

Windows 2000, Windows XP [Black Over Print] on [Advanced...] on the [Paper/Quality] tab in the
Printing Preferences dialog box.

Windows NT 4.0 [Black Over Print] on [Document Options] on the [Advanced] tab in the
Document Defaults dialog box.

Mac OS [Black Over Print:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Black Over Print] on the [Features 2] tab on [Printer Features] in the
print dialog box.

1¥Important

3 If you use Windows 95/98/Me, you can configure [Black Over Print] in [Advanced] by selecting [Manual]
from the [Color] setting.
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Toner Saving

Use this function to reduce the amount of toner used when printing.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Toner Saving] on the [Print Quality] tab.

Windows 2000, Windows XP [Toner Saver] on [Advanced...] on the [Paper/Quality] tab in the Print-
ing Preferences dialog box.

Windows NT 4.0 [Toner Saver] on [Document Options] on the [Advanced] tab in the
Document Defaults dialog box.

Mac OS [Toner Saver:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Toner Saver] on the [Features 1] tab on [Printer Features] in the print
dialog box.

Color Control

Use this to select whether or not you want the colors in the documents to be adjusted before printing so
that the printed page matches closer to the colors on the screen.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me The [Print Quality] tab.

Windows 2000, Windows XP [Graphic] on [Advanced] on the [Paper/Quality] tab in the Printing
Preferences dialog box.

Windows NT 4.0 This function is not available.

Mac OS [Print Color] on the [Color Matching] tab in the print dialog box.

Mac OS X This function is not available.
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& Note
3 If you use Windows 2000 or Windows XP, this function is called "Image Color Management".

3 If you use Windows NT 4.0, this function can not be configured.
3 If you use Mac OS, this function is called "Color Matching".

< Image Color Control
Display the Image Color Matching dialog box, click this button to specify exactly how you want the
colors on your screen adjusted before printing.

User Code

Use this to set a user code for print logging.

Enter a user code using up to eight digits. A user code identifies a group of users and allows you to
check the number of sheets printed under each code with SmartNetMonitor for Admin.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [User Code] on the [Statistics] tab.
Windows 2000, Windows XP [User Code] on the [Job Log] tab in the Printing Preferences dialog
box.
Windows NT 4.0 [User Code] on the [Job Log] tab in the Document Defaults dialog box.
Mac OS [User Code] on [Job Log] in the print dialog box.
Mac OS X This function is not available.
A~ Reference

For more information about using SmartNetMonitor for Admin, see Help.




<

Options

See “Setting Up Options” in the Client Reference or the Administrator Reference for the installation
method appropriate to your printing environment.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Option] on the [Accessories] tab.
Windows 2000, Windows XP [Installable Options] on the [Device Setting] tab.
Windows NT 4.0 [Installable Options] on the [Device Setting] tab in the Document De-
faults dialog box.
Mac OS [Chooser] on the Apple Menu.
Mac OS X This function is not available.
% Tray 2

* You can select the tray with the following menu for PAPER FEED UNIT Type 3000:
Paper Source= p.20

< Tray 3
* You can select the other tray with the following menu for an additional PAPER FEED UNIT

Type 3000:
Paper Source= p.20

& Note
3 If you use Windows 2000, Windows XP, Windows NT 4.0, Mac OS or Mac OS X, this menu
is called "Tray 2 and 3".
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« Duplex Unit
* You can use the following function with AD440:
Duplex Printing= p.14

< Hard Disk

* You can use the following function with Printer Hard Disk Type 3000:
Collate= p.13

& Note
3 This function is for Windows 95/98/Me only.

< Total Memory

* You can use the following function with Memory Unit Type C (64/128/256 MB):
Collate= p.13

& Note
3 The optional Memory Unit of at least 128MB must be installed on the printer.

3 This function is for Windows 95/98/Me only.




<«

2. Printer Utility for Mac

By using Printer Utility for Mac, you can download fonts, change the name of the printer and so on.

? Limitation
3 If a Macintosh and printer are connected by USB, you cannot use Printer Utility for Mac.

& Note

3 Printer Utility for Mac is included on the CD-ROM labeled “Printer Drivers and Utilities”.

3 Printer Utility for Mac requires Mac OS 8.1 or later. (Mac OS X Classic environment is supported.)
3 Printer Utility for Mac cannot use Mac OS X (native mode).

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the machine.
n Start the Macintosh.

B Insert the CD-ROM into the CD-ROM drive.
The CD-ROM icon appears.

B Double-click the icon of hard disk to open it.

ﬂ Double-click the CD-ROM icon.
The contents of the CD-ROM appear.

B Double-click the [Mac OS] folder.

E Double-click the [PS Utility] folder on the CD-ROM, and then drag the [Printer Utility for Mac]
file, and then drop it into the Macintosh hard disk.

ﬂ Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.
Printer Utility for Mac is installed. J—‘
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Starting Printer Utility for Mac

The following instructions describe how to start Printer Utility for Mac.

{¥Important
3 Before starting Printer Utility for Mac, confirm that the printer is selected with [Chooser] on the Apple
menu.

n Double-click the Printer Utility for Mac icon.
The Printer Utility for Mac dialog box appears.

ﬂ Click [OK].
Printer Utility for Mac will take a few seconds to start.

~ Reference
For more information, see “Printer Utility for Mac Functions”.
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Printer Utility for Mac Functions

Printer Utility for Mac functions are described below.

< File menu

[Download PS Fonts...]
Download fonts (PostScript Type 1) to the printer. See p.36 “Downloading PS Fonts™.

[Display Printer's Fonts...]

Display and delete the fonts in printer memory and the printer's hard disk drive. See p.38 “Dis-
playing Printer's Fonts”.

[Initialize Printer's Disk...]

Initialize the printer's hard disk drive. See p.39 “Initializing the Printer Disk™.

[Page Setup...]

Set up the paper size to print “Printer Font Catalog” and “Printer Font Sample”. See p.40 “Page
Setup”.

[Print Font Catalog...]
Print the names of available fonts. See p.40 “Printing Font Catalog”.

[Print Font Sample...]

Print a sample of fonts. See p.40 “Printing Font Sample”.

[Rename Printer...]

Change the printer's name when viewed via Appletalk. See p.41 “Renaming the Printer”.

[Restart Printer]
Restart the printer. See p.42 “Restarting the Printer”.
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« Utility menu
» [Download PostScript File...]
Download a PostScript File. See p.42 “Downloading PostScript Files”.

* [Select Zone...]
Change the zone to which the printer belongs to via Appletalk. See p.43 “Selecting the Zone”.
+ [Display Printer Status...]
Display the status of the printer. See p.44 “Displaying the Printer Status”.
 [Launch Dialogue Console...]
Create and edit a PostScript file, and then download it to the printer. See p.44 “Launching the
Dialogue Console”.

Downloading PS Fonts

You can download the PS fonts to the printer's memory or hard disk drive.

{¥Important
3 The following procedures to download the fonts assume that you are a system administrator. If you
are not, be sure to consult your system administrator.

3 If the printer restarts, all the printer settings return to their defaults.
O Confirm that a Macintosh and the printer are connected with Appletalk.

& Note
O Some fonts cannot be downloaded.

O Before downloading, read the documentation about the fonts you want to use.

n Select [Download PS Fonts...] on the [File] menu.
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ﬂ Click [Add to list].
The dialog box to select fonts appears.

B Click to select the desired font files, and then click [Open].
The list of selectable font names appears.

ﬂ After adding all the fonts you want to download, click [OK].
The dialog box of selected fonts to download appears.

B Click [Download].
The fonts begin to download, and the download status is shown.

1¥Important
3 During the download, do not turn off the power switch, operate the panel or open or close the
cover.

B When the completion message appears, click [OK].
ﬂ Click [Cancel].
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Displaying Printer's Fonts

You can display the available fonts currently downloaded to the printer. Fonts in the printer's memory
and hard disk drive can be displayed.

& Note
3 The fonts displayed in italics are the default fonts.

l] Select [Display Printer's Fonts...] on the [File] menu.
A dialog box appears.

B Select [Printer's memory] or [Printer's disk].
B Click [OK].

Deleting Fonts

You can delete fonts from the printer's memory or hard disk drive.

l] Select [Display Printer's fonts] on the [File] menu.
A dialog box appears.

B Select [Printer's memory] or [Printer's disk].

B Select the fonts you want to delete.
? Limitation

O You cannot delete the fonts displayed in italic.

ﬂ Click [Delete].
A confirmation message appears.
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B Confirm the fonts you want to delete and the printer name from which you want to delete the
fonts.

E Click [Continue], and then click [OK].
ﬂ Click [OK].

Initializing the Printer Disk

When initializing the printer's hard disk, all the fonts downloaded to the printer's hard disk drive are
deleted. Before initializing, be sure to check the fonts on the hard disk drive.

i@klmportant

3 When initializing the printer's hard disk drive from the operation panel, all of the data on the printer's
hard disk drive is deleted. Before initializing, be sure to check the data on the hard disk drive.

l] Select [Initialize Printer's Disk...] on the [File] menu.
The confirmation message appears.

& Note
3 To cancel initialization, click [Cancel].

ﬂ Click [Execute].
Initializing starts.

1¥Important
O Do not turn off the power switch until initializing is completed, otherwise the hard disk drive might
be damaged.

B When the completion message appears, click [OK].
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Page Setup

You can set the paper size on which to print “Print Fonts Catalogue” and “Prints Fonts Sample”.
n Select [Page Setup...] on the [File] menu.

B Choose the paper size.

Printing Font Catalog

Print the names of fonts available on the printer.

& Note
3 The paper selected under [Page Setup] is used.

l] Select [Print Fonts Catalogue] on the [File] menu.
B Click [Print].

Printing Font Sample

You can print samples of fonts downloaded to the hard disk drive or memory.

& Note
3 Print by using the paper selected on [Page Setup].

n Select [Print Fonts Sample...] on the [File] menu.
B Click [Print].
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Renaming the Printer

You can change the printer's name displayed under Appletalk. If you connect several printers on the
network, assign different names so you can identify them. If several printers have the same name, a digit
appears next to the printer name in [Chooser].

n Select [Rename Printer...] on the [File] menu.
B Type a new name in the [New Name:] field.

? Limitation
3 You can enter up to 31 digits and letters.
3 Do not use symbols, for example “*”, “”, “=","@”, “~”.

B Click [Rename].
The printer name is changed.

ﬂ Press [OK].

B Select [Chooser] on the Apple menu.

E Click the [AdobePS] icon.

ﬂ Click to select the printer name renamed in step F], and then close [Chooser].

& Note
O If there are several Appletalk zones, select the zone to which the printer belongs to.
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Restarting the Printer

You can restart the printer.
l] Select [Restart Printer] on the [File] menu.

B Confirm the message that appears on the screen, and then click [Restart].
The printer restarts.

& Note
3 The fonts that you downloaded in the printer's memory will be deleted.

3 If the printer restarts, all the printer settings return to their defaults.

Downloading PostScript Files

You can download a Postscript file to the printer.
l] Select [Download PostScript File...] on the [Utility] menu.
B Select the file name to download and click the file name, and then click [Open].

B Type the log file name, and then click [Save].
The selected file is downloaded.

& Note
3 Errors are recorded in the log file.
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Selecting the Zone

You can change the zone to which the printer belongs to via Appletalk.

1¥Important
3 Confirm that the printer and a Macintosh are connected in an Appletalk environment.

n Select [Select Zone...] on the [Utility] menu.
The zone to which the printer belongs to and the available zone list appear.

ﬂ Select the zone to which you want to switch the printer, and then click [Change].
A confirmation message appears.

B Click [Continue].
A confirmation message appears.

ﬂ Press [OK].

B Select [Chooser] on the Apple menu.

B Click the [AdobePS] icon.

ﬂ Select the zone selected in step f] on the [Appletalk zone:] list.

B Click to select the printer you want to use on the [Select a PostScript Printer:] list.
ﬂ Close [Chooser].
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Displaying the Printer Status

You can display and confirm the current status of the printer.

l] Select [Display Printer Status...] on the [Utility] menu.
The current status of the printer appears.

ﬂ Confirm the current status of the printer.

You can confirm the memory capacity, the VM (Virtual Memory) space, the hard disk drive status
and available space on the hard disk drive. You can also confirm the zone to which the printer be-
longs to.

B ciick [ok).

Launching the Dialogue Console

You can create and edit a PostScript file for printing, and then download it to the printer.

i@klmportant
3 “Launch Dialogue Console” is recommended for users with an understanding of PostScript.

3 Do not download any file other than PostScript files to the printer.
3 “Launch Dialogue Console” must be used at your own responsibility.

l] Select [Launch Dialogue Console...] on the [Utility] menu.
Open the editing screen. The Dialogue Console menu bar appears.
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ﬂ Type the PostScript command in the editor screen.

& Note
O To edit a PostScript file, select [Open] on the [File] menu to open it.
3 You can search or replace a character string by using the [Search] menu.

B After editing the PostScript file, select [Download Top Window] on [Console] menu to start print-
ing.
The PostScript file is sent to the printer.

& Note
3 The [Reply from Printer] box opens, depending on the PostScript file you sent.

ﬂ Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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